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Introduction E-MU / ENSONIQ's new SoundFont Player is an exciting 
software application which enables you to: 
 

§ play presets from a SoundFont bank using an 
external MIDI keyboard, the virtual MIDI 
keyboard included in the application, or your 
computer's ASCII keyboard. 

§ browse through all of the SoundFont banks 
located on your computer's local drives (hard 
drives, CD-ROM drives, zip drive, diskette drive, 
etc.) 

§ create custom SoundFont-compatible banks using 
existing presets. 

§ adjust global parameters of a preset such as  
Filter Fc, Filter Q, Pitch Coarse, Pitch Fine, LFO1 
Rate, LFO1 Filter, LFO1 Volume, and many other 
parameters.  These parameters can be adjusted 
by moving user-friendly sliders and graphs. 

§ edit preset settings and bank properties such as 
the preset name, the preset ID, the bank ID, the 
location of the preset within the bank (melodic or 
percussive), the bank name, etc. 

 

The SoundFont Player has the following minimum system 
requirements: 

§ Pentium 133 mHz 
§ Windows 95/98/2000/ME/XP 
§ 32MB of memory (64MB recommended) 
§ 10MB hard drive space 
§ A Creative Labs Sound Blaster Audigy or Sound 

Blaster Live! audio card or an E-MU Audio 
Production Studio or 8710 PC Card (PCMCIA). 

 

 

 

About 
SoundFont 
Player 

System 
Requirements 
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To install the SoundFont Player, please follow these steps: 

1. If you obtained the SoundFont Player as part of 
a bundle, with the SoundFont Player being 
included on a CD, please insert the CD into 
your CD-ROM drive.  If you downloaded the 
SoundFont Player from SoundFont.com (or 
another source), please skip down to Step 10. 

2. Click on the "Start" button in the lower left 
hand corner of your computer screen. 

3. Move your cursor up to the "Run…" item and 
click on it. 

4. This will open a dialog box appropriately 
named "Run" 

5. Click on the "Browse" button  

6. This will open a dialog box appropriately 
named "Browse" which contains the directory 
structure of your computer in its main window. 

7. Find the Setup.exe file on the installation CD. 
Note that the drive letter of your CD-ROM drive 
(usually "D:/") must appear in the "Look in:" 
field at the top of the "Browse" dialog box. If it 
does not appear in that field, click on the arrow 
at the right of the "Look in:" field -- this will 
allow you to choose the drive letter of your 
CD-ROM drive. 

8. Once you have found the Setup.exe file on the 
installation CD, double click on it. This will 
return you to the "Run" dialog box, and you 
will notice that the path to the Setup.exe file 
now appears in the "Open" field.  

9. Click the "OK" button, and the SoundFont 
Player installation routine will begin. 

Note: During the ensuing installation process, you will 
be taken through several screens (use the "Next >" and 
"< Back" buttons to navigate back and forth between 
these screens): 

Installation 
Instructions 
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§ the Welcome screen, which will request that you 
close all Windows programs currently running.  
Click the "Next >" button to proceed to the next 
screen or the "Cancel" button to leave the 
installation, close all currently running Windows 
programs, and begin the installation routine 
again. 

§ the Software License Agreement screen, which 
will ask that you agree to the license agreement 
for the SoundFont Player.  Clicking the "Yes" 
button will advance you to the next installation 
screen.  Clicking the "No" button will cancel the 
installation.  Clicking on the "< Back" button will 
return you to the Welcome screen. 

§ the Choose Destination Location screen, at which 
you can choose where you will place the 
application on your hard drive.  We recommend 
that you do not change the default location which 
is shown, but if you wish to install the application 
into a different directory, you can click the 
"Browse" button to access the directory structure 
of your computer.  Once you have either kept the 
default location or chosen another location, you 
can click on the "Next >" button to proceed to 
the next installation screen.  Clicking on the 
"< Back" button returns you to the Software 
License Agreement screen while clicking on the 
"Cancel" button will close the installation routine. 

§ the Select Program Folder screen, at which you 
can choose the name of the Program Folder 
(which is the name of the folder which will appear 
on your Start | Programs menu after installation).  
We recommend that you do not change the 
default name which is displayed, but if you wish, 
you may edit the name or choose an existing 
folder from the Existing Folders list.  When you 
click on the "Next >" button on this screen, the 
installation of the SoundFont Player files will 
begin.  If you click on the "< Back" button, you 
will return to the Choose Destination Folder 
screen.  Clicking on the "Cancel" button will close 
the installation routine. 

§ When the installation of the SoundFont Player 
files has been completed, the Setup Complete 
screen will appear.  Click on the "Finish" button, 
and the installation program will close. 

You can ignore steps 10-20, which are meant for 
those who downloaded the SoundFont Player. 



SoundFont Player Operation Manual Page 9 

10. If you downloaded the SoundFont Player from 
SoundFont.com (or another source), you will 
have downloaded a file named 5223.zip.   

Note: It is very important that you remember the 
location of the directory into which you download the file 
– in fact, we would recommend that you write down the 
location (you can discover the location in your directory 
structure by clicking once on the downward-pointing 
arrow at the right of the drag down box in the "Save As" 
dialog box which appears when you begin to download 
the file - click on that arrow again to close the directory 
structure). 

11. Before you can install the SoundFont Player 
application, you will need to decompress the 
5223.zip file.  We recommend using WinZip 
software for this purpose, but any standard zip 
utility will decompress the file.  Please consult 
Appendix A to this manual for instructions on 
using WinZip. 

Note: It is very important that you remember the 
location of the directory into which you decompress (or 
unzip) the files contained in the 5223.zip file. In fact, we 
would recommend that you write down the location (in 
WinZip, once you open a .zip file and click on the 
"Extract" button, you will be presented with a dialog box 
entitled "Extract" – in the top left-hand corner of that 
dialog box, a field entitled "Extract to" will display the 
directory into which you will decompress the contents of 
the zip file.  Note that you can either edit that field 
directly to change the directory or you can choose a 
different directory in the "Folders/drives" window of the 
"Extract" dialog box.  Other zip utilities will have 
different paradigms, but you should be able to change 
the directory into which you will decompress the files in 
any zip utility you employ). 

12. Once the 5223.zip file has been decompressed, 
click on the "Start" button in the lower left-
hand corner of your computer screen. 

13. Move your cursor up to the "Run..." item and 
click on it.  

14. This will open a dialog box appropriately 
named "Run". 

15. Click on the "Browse" button. 
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16. This will open a dialog box appropriately 
named "Browse" which contains the directory 
structure of your computer in its main window. 

17. Find the Setup.exe file on your hard drive (in 
the directory into which you decompressed the 
files contained in the 5223.zip file). If that 
directory does not appear in the "Look in:" 
field, click on the arrow at the right of the 
"Look in:" field -- this will allow you to switch 
to the proper directory. 

18. Once you have found the Setup.exe file on 
your hard drive, double click on it. This will 
return you to the "Run" dialog box, and you 
will notice that the path to the Setup.exe file 
now appears in the "Open" field.  

19. Click the "OK" button, and the SoundFont 
Player installation routine will begin. 

20. Follow the onscreen instructions to complete 
the installation of the SoundFont Player. 

Note: During the ensuing installation process, you will 
be taken through several screens (use the "Next >" and 
"< Back" buttons to navigate back and forth between 
these screens): 

§ the Welcome screen, which will request that you 
close all Windows programs currently running.  
Click the "Next >" button to proceed to the next 
screen or the "Cancel" button to leave the 
installation, close all currently running Windows 
programs, and begin the installation routine 
again. 

§ the Software License Agreement screen, which 
will ask that you agree to the license agreement 
for the SoundFont Player.  Clicking the "Yes" 
button will advance you to the next installation 
screen.  Clicking the "No" button will cancel the 
installation.  Clicking on the "< Back" button will 
return you to the Welcome screen. 

§ the Choose Destination Location screen, at which 
you can choose where you will place the 
application on your hard drive.  We recommend 
that you do not change the default location which 
is shown, but if you wish to install the application 
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into a different directory, you can click the 
"Browse" button to access the directory structure 
of your computer.  Once you have either kept the 
default location or chosen another location, you 
can click on the "Next >" button to proceed to 
the next installation screen.  Clicking on the 
"< Back" button returns you to the Software 
License Agreement screen while clicking on the 
"Cancel" button will close the installation routine. 

§ the Select Program Folder screen, at which you 
can choose the name of the Program Folder 
(which is the name of the folder which will appear 
on your Start | Programs menu after installation).  
We recommend that you do not change the 
default name which is displayed, but if you wish, 
you may edit the name or choose an existing 
folder from the Existing Folders list.  When you 
click on the "Next >" button on this screen, the 
installation of the SoundFont Player files will 
begin.  If you click on the "< Back" button, you 
will return to the Choose Destination Folder 
screen.  Clicking on the "Cancel" button will close 
the installation routine. 

§ When the installation of the SoundFont Player 
files has been completed, the Setup Complete 
screen will appear.  Click on the "Finish" button, 
and the installation program will close. 

 

Throughout this manual, you will periodically see certain 
icons and further notes in the left-hand margin of the 
page.  The following are explanations for the icons, or 
symbols, you will see in the margins: 

This push-pin icon lets you know that you 
can find further explanatory notes in the 
margin.  It is most often used for definitions 
of terms in the main portion of the manual. 

This exclamation point lets you know that 
something very important in the 
instructions for the application appears 
here.  Please play close attention! 

This profile of a very smart dude lets you 
know that a particular section of the manual 
is somewhat technical.  If you're just 

Margin Icons 

!
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getting started with SoundFont technology, 
you can safely skip over these sections. 
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The SoundFont Player application is comprised of four 
basic "panels": 

§ The Main Panel 

        

 

§ The SoundFont Bank Browser Panel 

        

Parts of the 
Screen 
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§ The Global Parameters, or Advanced, Panel 
(which is closed by default when you launch the 
application, but can be opened by clicking on the 
Advanced button in the Main Panel) 

        

 

§ The Virtual MIDI Keyboard Panel 
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The Main Panel is made up of seven different elements 
(please see the screen shot which appears after the 
following list of elements): 

§ The Browser Button, which opens and closes the 
SoundFont Bank Browser Panel. 

§ The Drum Kit Button, which, when pressed, 
toggles between displaying regular instrument 
sounds and drum kit (percussive) sounds in the 
Main Preset Window; this corresponds to MIDI 
Channel 10, as defined by the General MIDI 
standard. 

§ The Advanced Button, which opens and closes the 
Global Parameters, or Advanced, Panel. 

§ The Memory Meter, which displays in graphical 
form the amount of free memory on your 
computer system. 

§ The Main Preset Window, which displays the 
SoundFont presets which you have loaded into 
your system's memory. 

§ The Volume Slider, which adjusts the volume of 
the preset when played. 

§ The Pan Meter and Adjustment Slider, which 
display and adjust the relative volumes of the left 
and right channels, i.e., the left and right 
speakers. 

               

 

 

Main Panel 

Pan = short for 
"panorama".  The 
basic idea is akin 
to the "balance" 
setting on your 
stereo – adjusting 
the pan one way 
increases the 
volume coming 
out of your left 
speaker, while 
adjusting the pan 
the other way 
increases the 
volume coming 
out of your right 
speaker. 
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The SoundFont Bank Browser Panel is made up of two 
different elements (please see the screen shot which 
appears after the following list of elements): 

§ The SoundFont Bank List, which displays all of the 
SoundFont banks currently cataloged by the 
SoundFont Player (in general, this means every 
SoundFont bank on all local drives – hard drives, 
CD-ROM drives, zip drive, diskette drive, etc. – 
the only exception to this is if you have inserted 
new media such as a new SoundFont CD and have 
not yet re-cataloged). 

§ The SoundFont Presets List, which displays all of 
the presets contained in the SoundFont bank you 
have selected in the SoundFont Bank List. 

               

 

The Global Parameters, or Advanced Panel, is made up of 
fourteen different main sliders, a Volume Envelope Control, 
a Filter and Pitch Envelope Control, Filter and Pitch sliders, 
and a Reset button (please see the screen shot which 
appears below).  The functions which correspond to these 
controls will be further explained in the section of this 
manual entitled, "How to Adjust Global Parameters." 

         

SoundFont 
Bank Browser 
Panel 

Global 
Parameters 
Panel 
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The Virtual MIDI Keyboard Panel is made up of four 
different elements (please see the screen shot which 
appears after the following list of elements).  The functions 
which correspond to these controls will be further 
explained in the section of this manual entitled, "How to 
Play a Preset." 

§ The Keys (white and black), for playing a sound 

§ The Octave Arrows, for selecting the current 
keyboard range 

§ The "Middle C" Indicator (the small black dot 
which, when the application is launched, appears 
in the middle of the keyboard) 

§ The Octave Indicator (the small, upward-pointing 
green arrow just under the keyboard) 

 

 

 

 

 

 

 

 

 

 

 

 

Virtual MIDI 
Keyboard Panel 

Octave = on a 
keyboard, an 
octave is the 
distance between 
notes of the same 
name 

Middle C = on a 
keyboard, Middle 
C is the "C" note 
which appears 
more or less at 
the center of the 
piano keyboard.  
Middle C also 
corresponds to 
MIDI note 60. 
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You can launch the SoundFont Player in one of two ways: 

1. Double click on the SoundFont Player icon 
which, after the installation is complete, should 
appear on your Windows desktop.  This will 
launch the application – if you choose this 
approach, you can ignore steps 2-4 directly 
below. 

OR 

2. Click on the "Start" button in the lower left-
hand corner of your computer screen. 

3. Move your cursor up to the "Programs" item, 
then over to the right to the "SFPlayer 1.0" 
item, and finally over to the right to the 
additional "SFPlayer 1.0" item. 

4. Click on this second "SFPlayer 1.0" item, and 
the SoundFont Player application will be 
launched. 

 

The first time you launch the SoundFont Player application, 
you will see a notice which asks if you would like to create 
a new catalog (of the SoundFont banks on your system).  
Click the "Yes" button to continue. 

While the SoundFont Player is building a new catalog, you 
will see a notice telling you that the SoundFont Player is 
cataloging SoundFont banks. 

Once all of the SoundFont banks on all of your local drives 
(hard drives, CD-ROM drives, zip drive, diskette drive, 
etc.) have been cataloged, the SoundFont Player Desktop 
will be launched.   

 

Before you will be able to play a preset, you will need to 
select your MIDI In and MIDI Out devices to tell the 
application which device to receive MIDI signals from and 
which device to send MIDI signals to.  This is less 
complicated than it sounds.  In order to select your MIDI 
In and MIDI Out devices, please follow these steps: 

Getting 
Started 

Launching the 
Application 

Launching the 
SoundFont 
Player for the 
First Time 

Selecting MIDI 
In and MIDI 
Out Devices 
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1. In order to select your MIDI In device, choose 
the "Select MIDI In Device …" menu item from 
the File menu. 

2. This will open a dialog box entitled "Select 
MIDI IN Device."  This dialog box will contain a 
list of devices from which to choose.  Click on 
the name of your sound card (the item may 
refer to a specific function of your sound card 
such as "SB Live! MIDI UART"), and click on 
the "Open" button. 

3. In order to select your MIDI Out device, 
choose the "Select MIDI Out Device …" menu 
item from the File menu. 

4. This will open a dialog box entitled "Select 
MIDI OUT Device."  This dialog box will contain 
a list of devices from which to choose.  There 
is a good chance that your sound card will be 
named twice, preceded by "A:" and "B:" – you 
may click on either device.  Click on the name 
of your sound card (the item may refer to a 
specific function of your sound card such as 
"SB Live! MIDI Synth"), and click on the 
"Open" button. 

 

This "Quick Tour" is designed to give you a brief 
introduction to the SoundFont Player application.  More in-
depth treatments of the different functions of the 
SoundFont Player, such as the various parts of the 
SoundFont Player Desktop, how to open and close different 
panels, how to play presets, how to adjust global 
parameters, etc., are included later in this manual.  For 
the moment, however, our goal is to allow you to start 
playing SoundFont banks as soon as possible. 

To play your first preset from a SoundFont bank, please 
follow these steps: 

1. Double click on any SoundFont bank from the 
SoundFont Bank list contained in the 
SoundFont Bank Browser panel of the 
SoundFont Player. 

Quick Tour 

bank: a bank, or 
more precisely, a 
SoundFont bank, 
is a collection of 
musical instru-
ment and audio 
sounds which can 
be played through 
your computer 
(provided your 
sound card is  
SoundFont-
compatible. 

!
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2. When you double-click on a SoundFont bank in 
the SoundFont Bank list, the presets contained 
in that SoundFont bank will be loaded into your 
system's memory, and those presets will 
appear in the Main Preset Window in the Main 
Panel of the SoundFont Player application.  
While the presets are being loaded into your 
system memory, you may see a notice telling 
you that the SoundFont Player is loading your 
selected presets and asking you to wait. 

3. Click once on the preset you wish to play (in 
the Main Preset Window). 

4. If you have an external MIDI keyboard 
connected to your computer, start pressing its 
keys 

Note: Not all SoundFont presets are "mapped" over the 
entire keyboard, so depending on which preset you 
chose in Step 3 above, you may need to press different 
keys to find the range of keys applicable to that 
particular preset.  Standard instruments such as pianos 
generally cover the entire range of an external MIDI 
keyboard. 

Further Note: If you have an external MIDI keyboard, 
but you aren't sure how to connect it to your computer, 
please see Appendix B ("Connecting an External MIDI 
Keyboard"). 

6. If you do not have an external MIDI keyboard, 
you can play the preset by clicking on the 
Virtual MIDI Keyboard with your cursor (or 
clicking and dragging your cursor over the 
Virtual MIDI Keyboard. 

7. Alternatively, you can play the preset with the 
ASCII keyboard of your computer.  Use the 
following keys on your ASCII keyboard to play 
the preset: 

i. The "A", "S", "D", "F", "G", "H", and "J" 
keys correspond to the white keys of the 
Virtual MIDI Keyboard. 

preset: a preset, 
or more precisely, 
a SoundFont 
preset, is an 
individual musical 
instrument or 
sound effect which 
is contained in a 
SoundFont bank. 
 
There can be 
many SoundFont 
presets within a 
single SoundFont 
bank. 
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ii. The "W", "E", "T", "Y", and "U" keys 
correspond to the black keys of the 
Virtual MIDI Keyboard. 

iii. The "K" and "L" keys allow you to shift 
octaves up and down. 

iv. You may also use the "1" through "0" 
keys to shift octaves up and down. 

 

We suggest that you play a bit with the application – 
become accustomed to choosing SoundFont banks and 
presets, loading them into your system memory, and 
playing them with an external MIDI keyboard, the Virtual 
MIDI Keyboard, and/or the ASCII keyboard of your 
computer.   

Depending on the amount of available memory on your 
system, you may need to clear your sound memory after 
having loaded numerous presets. You will know this is true 
when you see a notice which says that all of your preset 
locations are full and asks that you delete presets or clear 
memory. 

Click on the OK button and either delete individual presets 
from the Main Preset Window (by right-clicking on the 
preset and choosing "Delete" from the resulting drop-down 
menu) or by choosing the "Clear Sound Memory" menu 
item from the Edit menu (this will clear all SoundFont 
presets from your system memory).  

Remember - when you are first starting out, the most 
important thing is to not get bogged down in too many 
details.  Have some fun! 
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The SoundFont Player includes three basic menus: 

§ File 

§ Edit (the Edit menu will not appear until you load 
a preset into the Main Preset Window) 

§ Help 

The File Menu includes the following menu items: 

§ Open: This menu item opens a File Open Dialog 
Box which allows you to select a SoundFont bank 
from one of your local drives (hard drives, CD-
ROM drives, zip drive, diskette drive, etc.) and 
load the entire bank into your system's memory.  
The presets contained in the loaded SoundFont 
bank will then appear in the Main Preset Window. 

§ Close (appears only when one or more 
SoundFont presets are loaded into your 
system's memory): This menu item closes the 
already loaded SoundFont presets and clears your 
system's memory. 

§ Save (appears only when one or more 
SoundFont presets are loaded into your 
system's memory): This menu item allows you 
to save any edits you have made to a SoundFont 
bank.  It also allows you to save any SoundFont 
presets which you have loaded individually into 
the Main Preset Window into a new SoundFont-
compatible bank. 

§ Properties: This menu item allows you to view 
information regarding the SoundFont bank which 
is loaded into memory.  If you have loaded 
individual presets into system memory from one 
or more existing SoundFont banks, the SoundFont 
Player considers the loaded presets to be a new 
SoundFont-compatible bank (whether or not you 
plan to save it as such), and thus, the amount of 
information which the Properties dialog box will 
display for such a "new bank" is minimal. 

§ Recently Opened Files: This portion of the File 
menu displays previously-loaded SoundFont 

Using the 
Menus 

File Menu 
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banks.  The last four opened banks are displayed 
in this list which appears on the File menu just 
above the "Select MIDI In Device …" menu item. 

§ Select MIDI In Device: This menu item opens a 
dialog box which displays all the SoundFont-
compatible MIDI In Devices which are a part of 
your system.  For proper operation, you must 
select one of these MIDI In devices when the 
SoundFont Player is launched for the first time 
after installation. 

§ Select MIDI Out Device: This menu item opens 
a dialog box which displays all the SoundFont-
compatible MIDI Out devices which are a part of 
your system.  For proper operation, you must 
select one of these MIDI Out devices when the 
SoundFont Player is launched for the first time 
after installation. 

 

The Edit Menu includes the following menu items: 

§ Cut: This menu item allows you to remove 
presets from one SoundFont bank (in preparation 
for pasting them into another or a new SoundFont 
bank through the Edit | Paste menu item). 

Note: "New" SoundFont-compatible banks are begun when 
you load an individual preset into the Main Preset Window 
from an existing SoundFont bank.  

§ Copy: This menu item allows you to copy presets 
from one SoundFont bank (in preparation for 
pasting them into another or a new SoundFont 
bank through the Edit | Paste menu item). 

§ Paste: This menu item allows you to paste a 
preset which has been earlier cut or copied from 
another SoundFont bank into the SoundFont bank 
which is currently loaded (or into a new 
SoundFont-compatible bank). 

§ Delete: This menu item allows you to remove a 
preset from the currently-loaded SoundFont bank. 

Edit Menu 
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§ Bank ID: This menu item allows you to change 
the Bank ID of the currently-loaded SoundFont 
bank. 

§ Preset Settings: This menu item allows you to 
change various parameters of a selected preset 
such as the Preset ID, the Bank ID and the Preset 
Name.  The check box appearing in the dialog box 
which appears when you choose this menu item, 
if checked, will move the current preset to the 
Percussive Pool (drum kit section). 

§ Clear Sound Memory: This menu item clears 
SoundFont banks from your system's memory. 

 

The Help menu includes the following menu items: 

§ Help Topics: This menu item opens the 
SoundFont Player help system. 

§ Additional SoundFont Libraries: This menu 
item will launch your web browser and forward 
you to the Sounds page at SoundFont.com where 
you will be able to browse through various 
collections of SoundFont libraries (active internet 
connection).   

§ About SoundFont Player 1.0: This menu item 
opens a dialog box which provides basic 
information regarding the SoundFont Player 
application, including the current version number.  
Within the dialog box which is opened, clicking on 
the E-mu logo will launch the user's browser and 
load E-mu's website at 
http://www.soundfont.com (active internet 
connection required). 

 

 

 

 

 

Help Menu 

http://www.soundfont.com/new8.html
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The SoundFont Player includes four different panels (see 
the chapter in this manual entitled "Parts of the Screen" 
for more information on each of these panels). 

When you launch the SoundFont Player application, three 
panels are open by default: the Main Panel, the SoundFont 
Bank Browser Panel, and the Virtual MIDI Keyboard Panel. 

Two of these panels – the Main Panel and the Virtual MIDI 
Keyboard Panel – cannot be closed. 

 

The SoundFont Bank Browser Panel can be closed and 
opened by clicking on the "Browser" button in the Main 
Panel. 

The "Browser" button will turn red when the SoundFont 
Bank Browser Panel is closed and will return to its original 
green color when the SoundFont Bank Browser Panel is 
opened. 

 

The Global Parameters, or Advanced, Panel can be opened 
and closed by clicking on the "Advanced" button in the 
Main Panel. 

The "Advanced" button will turn green when the Global 
Parameters Panel is opened and will return to its original 
red color when the Global Parameters Panel is closed. 
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There are four different ways to play a SoundFont preset 
using the SoundFont Player application: 

§ with an external MIDI keyboard 

§ with the Virtual MIDI Keyboard included in the 
SoundFont Player application 

§ with the ASCII keyboard of your computer 

§ with a combination of the types of keyboards 
described above 

 

Note: If you have an external MIDI keyboard, but you aren't sure how 
to connect it to your computer, please see Appendix B ("Connecting an 
External MIDI Keyboard"). 

To play a SoundFont preset using an external MIDI 
keyboard, you will need to follow these steps: 

1. Select any SoundFont bank from the 
SoundFont Bank list contained in the 
SoundFont Bank Browser panel of the 
SoundFont Player. 

2. When you click on a SoundFont bank in the 
SoundFont Bank list, the presets contained in 
that SoundFont bank will be displayed in the 
SoundFont Preset List – just to the right of the 
SoundFont Bank List in the SoundFont Bank 
Browser panel. 

3. Select one of the presets in the SoundFont 
Preset List by double-clicking on it.  This will 
load that particular preset into your system 
memory, and the preset will appear in the Main 
Preset Window in the Main Panel of the 
SoundFont Player application.  While the preset 
is being loaded into your system memory, you 
may see a notice telling you that the 
SoundFont Player is loading your selected 
preset and asking you to wait. 

Note: You may also double-click on a SoundFont bank 
in the SoundFont Bank List.  Double-clicking on a 
SoundFont bank will load all of that particular bank's 
presets into the Main Preset Window in the Main Panel. 

How To Play 
a Preset 

Playing A Preset 
With An 
External MIDI 
Keyboard 
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4. Click once on the preset you wish to play (in 
the Main Preset Window). 

5. Begin pressing the keys on your external MIDI 
keyboard. 

Note: Not all SoundFont presets are "mapped" over the 
entire keyboard, so depending on which preset you 
chose in Step 3 above, you may need to press different 
keys to find the range of keys applicable to that 
particular preset.  Standard instruments such as pianos 
generally cover the entire range of an external MIDI 
keyboard. 

 

To play a SoundFont preset using the Virtual MIDI 
Keyboard included in the SoundFont Player application, 
you will need to follow these steps: 

1. Select any SoundFont bank from the 
SoundFont Bank list contained in the 
SoundFont Bank Browser panel of the 
SoundFont Player. 

2. When you click on a SoundFont bank in the 
SoundFont Bank list, the presets contained in 
that SoundFont bank will be displayed in the 
SoundFont Preset List – just to the right of the 
SoundFont Bank List in the SoundFont Bank 
Browser panel. 

3. Select one of the presets in the SoundFont 
Preset List by double-clicking on it.  This will 
load that particular preset into your system 
memory, and the preset will appear in the Main 
Preset Window in the Main Panel of the 
SoundFont Player application.  While the preset 
is being loaded into your system memory, you 
may see a notice telling you that the 
SoundFont Player is loading your selected 
preset and asking you to wait. 

Note: You may also double-click on a SoundFont bank 
in the SoundFont Bank List.  Double-clicking on a 
SoundFont bank in this way will load all of that particular 
bank's presets into the Main Preset Window in the Main 
Panel. 

Playing A Preset 
With The Virtual 
MIDI Keyboard 
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4. Click once on the preset you wish to play (in 
the Main Preset Window). 

5. You can play the preset by clicking on the 
Virtual MIDI Keyboard with your cursor (or 
clicking and dragging your cursor over the 
Virtual MIDI Keyboard. 

Note: When using the Virtual MIDI Keyboard, you can affect the 
"velocity" of the note being played by clicking higher or lower on any 
individual key.  Clicking higher on the key results in less velocity, while 
clicking lower on the key results in more velocity.  Try it out! 

 

The "Octave Arrows" which appear at either side of the 
Virtual MIDI Keyboard can be used to select different 
octaves.  Clicking on the left octave arrow selects the next 
octave below the currently-selected octave, and clicking on 
the right octave arrow selects the next octave above the 
currently-selected octave. 

The "Middle C Indicator" (the small black dot on the Virtual 
MIDI Keyboard) signifies the location of "Middle C."  The 
"Octave Indicator" (the small green arrow just below the 
white keys of the Virtual Midi Keyboard) signifies the 
location of the "C" note of the currently-selected octave. 

When you move your cursor over the Virtual MIDI 
Keyboard without clicking on a key, a "tool tip" will pop up 
to tell you the corresponding key number and MIDI value 
of the particular key the cursor is over. 

 

To play a SoundFont preset using your computer's ASCII 
keyboard, you will need to follow these steps: 

1. Select any SoundFont bank from the 
SoundFont Bank list contained in the 
SoundFont Bank Browser panel of the 
SoundFont Player. 

2. When you click on a SoundFont bank in the 
SoundFont Bank list, the presets contained in 
that SoundFont bank will be displayed in the 
SoundFont Preset List – just to the right of the 

Playing A Preset 
With An ASCII 
Keyboard 

Velocity = In 
electronic music 
terms, "velocity" 
refers to how hard 
a key is pressed 
on a keyboard.  In 
general, the more 
velocity which is 
used, the higher 
the volume of the 
sound will be.  The 
less velocity which 
is used, the lower 
the volume of the 
sound will be. 
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SoundFont Bank List in the SoundFont Bank 
Browser panel. 

3. Select one of the presets in the SoundFont 
Preset List by double-clicking on it.  This will 
load that particular preset into your system 
memory, and the preset will appear in the Main 
Preset Window in the Main Panel of the 
SoundFont Player application.  While the preset 
is being loaded into your system memory, you 
may see a notice telling you that the 
SoundFont Player is loading your selected 
preset and asking you to wait. 

Note: You may also double-click on a SoundFont bank 
in the SoundFont Bank List.  Double-clicking on a 
SoundFont bank in this way will load all of that particular 
bank's presets into the Main Preset Window in the Main 
Panel. 

4. Click once on the preset you wish to play (in 
the Main Preset Window). 

5. You can play the preset with the ASCII 
keyboard of your computer by using the 
following keys: 

i. The "A", "S", "D", "F", "G", "H", and "J" 
keys correspond to the white keys of 
the Virtual MIDI Keyboard. 

ii. The "W", "E", "T", "Y", and "U" keys 
correspond to the black keys of the 
Virtual MIDI Keyboard. 

iii. The "K", and "L" keys allow you to shift 
octaves up and down.  The "K" key, 
when pressed, will select the next 
octave above the currently-selected 
octave, and the "L" key, when pressed, 
will select the next octave below the 
currently-selected octave.' 

iv. The number keys ("1" through "0") can 
also be used to shift octaves.  The "0" 
key, when pressed, will select the 
lowest possible octave, and the "9" key, 
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when pressed, will select the highest 
possible octave.  Keys "1" through "8" 
select octaves in sequence in between 
the lowest and highest possible 
octaves. 

 

You can play SoundFont presets using any combination of 
external MIDI keyboard, Virtual MIDI Keyboard, and ASCII 
keyboard. 

For example, you can play different notes using the Virtual 
MIDI keyboard and your ASCII keyboard at the same time.  
Or, you can use the "up" and "down" arrows of your ASCII 
keyboard to move to different presets in the Main Preset 
Window while using your external MIDI keyboard to 
actually play the presets. 
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Most SoundFont banks contain one or more drum kits in 
addition to their basic melodic presets.  Using the drum kit 
allows you to play percussion sounds.   

To access the drum kit of a SoundFont bank, load an entire 
bank by double-clicking on its name in the SoundFont 
Bank List which appears in the SoundFont Bank Browser 
Window.   

This will load all the presets in that particular bank into the 
Main Preset Window which is part of the Main Panel of the 
application. 

Click on the "Drum Kit" button located on the left-hand 
side of the Main Panel. 

This will cause the Main Preset Window to display only the 
presets located in the drum kit section (or percussive pool) 
of the SoundFont bank.  Clicking on the "Drum Kit" button 
again will cause the Main Preset Window to display the 
presets located in the primary section (or melodic pool) of 
the SoundFont bank. 

You can always tell which section (or pool) of the bank is 
being displayed in the Main Preset Window by noting the 
color of the "Drum Kit" button.  When the "Drum Kit" 
button is red, the Main Preset Window is displaying the 
presets located in the primary section (or melodic pool) of 
the SoundFont bank.  When the "Drum Kit" button is 
green, the Main Preset Window is displaying the presets 
located in the drum kit section (or percussive pool) of the 
SoundFont bank. 

Drum Kit presets are played in the same way other presets 
are played: 

1. Click once on the preset you wish to play (in 
the Main Preset Window). 

2. Use your external MIDI keyboard, the Virtual 
MIDI Keyboard, or your computer's ASCII 
keyboard to play the preset. 

 

 

How To 
Access 
Drum Kits 

Drum Kit = the 
portion or section 
of a SoundFont 
bank which in-
cludes percussion 
sounds.  Drum 
kits are in a 
special MIDI bank 
location (bank 
128).  When in 
General MIDI 
mode, MIDI 
Channel 10 is 
hard-wired to this 
special location. 
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In addition to the three buttons ("Browser", "Drum Kit", 
and "Advanced") and the Main Preset Window, the Main 
Panel of the SoundFont Player application includes three 
other features: the Memory Meter, the Volume Slider, and 
the Pan Meter and Adjustment Slider. 

The Memory Meter is located just to the right of the three 
buttons in the Main Panel. 

The Memory Meter displays the amount of system memory 
currently in use.  Successively-higher colored bars of the 
memory meter brighten as more system memory is used. 

 

The Volume Slider is located just to the right of the Main 
Preset Window and is used, not surprisingly, to adjust the 
volume of the preset being played. 

To adjust the volume of the preset, click on the small 
button located on the Volume Slider, hold the mouse 
button down and drag the button up and down. 

                                     

The Pan Meter and Adjustment Slider are located just to 
the right of the Volume Slider and are used to display and 
adjust the relative volumes of the left and right channels, 
i.e., the left and right speakers. 

To adjust the relative volumes of the left and right 
channels, click on the small button located on the Pan 
Adjustment Slider, hold the mouse button down and drag 
to the left or right. 

As you move the slider button, the Pan Meter will display 
the relative volumes of the left and right channels. 
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The Global Parameters, or Advanced, Panel of the 
SoundFont Player provides various controls which allow 
you to change various parameters of the selected preset 
prior to playing it. 

If you are not familiar with some of the terminology used 
in the electronic music realm (and which is used in this 
section of our manual), don't worry.  You can still use the 
controls on the Global Parameters Panel – nothing you do 
to a preset will ultimately change it unless you save the 
bank. 

The best way to understand how particular controls in the 
Global Parameters Panel effect a sound is to actually play a 
sound yourself while adjusting the various parameters and 
listening to the effect those adjustments have on the 
sound. 

In addition, changing the various parameters of a 
SoundFont preset may have somewhat different effects on 
the sound which is played, depending on your computer 
system and its speakers.  For that reason, the following 
explanations of the various controls represent general, 
rather than precise, descriptions. 

 

The Global Parameters Panel includes these 14 main 
sliders: 

§ Filter Fc 
§ Filter Q 
§ Pitch Coarse 
§ Pitch Fine 
§ LFO1 Rate 
§ LFO1 Filter 
§ LFO1 Volume 
§ LFO1 Pitch 
§ LFO1 Delay 
§ LFO2 Rate 
§ LFO2 Pitch 
§ LFO2 Delay 
§ Effects A 
§ Effects B 
 

 

Adjusting 
Global 
Parameters 

Using the Main 
Sliders 
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Filter Fc Slider 
This slider will allow you to adjust the amount by which the 
sound is "muffled."  When the button on the slider is 
moved to the very bottom of the slider, the sound will be 
more muffled, and when the button is moved to the very 
top of the slider, the sound will be less muffled. 

Imagine you are playing a grand piano.  When the cover of 
the piano is closed, the sound will be more muffled ("dark" 
is the musical term).  In the SoundFont Player, this quality 
can be reproduced by moving the button on the Filter Fc 
Slider as far down as possible.  When the cover of the 
piano is open, the sound will be less muffled ("bright" is 
the musical term).  In the SoundFont Player, this quality 
can be reproduced by moving the button on the Filter Fc 
Slider as far up as possible. 

For those who are interested in a more technical 
explanation, the Filter Fc Slider controls the cutoff and 
resonant frequency of the low pass filter in absolute cent 
units. The low pass filter is defined as a second order  
resonant pole pair whose pole frequency in Hz is defined 
by the Initial Filter Cutoff parameter. When the cutoff 
frequency exceeds 20kHz and the Q (resonance) of the 
filter is zero, the filter does not affect the signal. It also 
Sets the cutoff frequency of the low-pass filter (responsible 
for modifying the timbres of a preset). The lower the 
value, the "duller" a note will sound. 

 

Filter Q Slider 
This slider will allow you to adjust the "tinniness" of the 
sound.  When the button on the slider is moved to the very 
bottom of the slider, the sound will be less "tinny" in 
quality, and when the button is moved to the very top of 
the slider, the sound will be more "tinny" in quality. 
 
If you would like a more technical explanation, the Filter Q 
Slider controls the height above DC gain in centibels, 
which the filter resonance exhibits at the cutoff frequency. 
A value of zero or less indicates the filter is not resonant; 
the gain at the cutoff frequency (pole angle) may be less 
than zero when zero is specified. The filter gain at DC is 
also contrast “case-insensitive.” It sets the degree of 

Using the Filter Fc 
Slider 

Using the Filter Q 
Slider 
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resonance (quality of being deep, clear, and echoing) of an 
audio signal at the filter cutoff frequency. When you 
increase this value, you set greater emphasis on the signal 
at the filter cutoff frequency. 

 

Pitch Coarse Slider 
This slider will allow you to adjust the pitch in large 
increments. 

From a more technical standpoint, the Pitch Coarse Slider 
controls the pitch offset, in semitones, which should be 
applied to the note. A positive value indicates the sound is 
reproduced at a higher pitch; a negative value indicates a 
lower pitch. For example, a Coarse Tune value of -4 would 
cause the sound to be reproduced four semitones flat. 

 

Pitch Fine Slider 
This slider will allow you to adjust the pitch of the 
instrument in small increments. 

If you are interested in a more technical description, the 
Pitch Fine Slider adjusts the pitch offset, in cents, which 
should be applied to the note. It is additive with coarse 
Tune. A positive value indicates the sound is reproduced at 
a higher pitch; a negative value indicates a lower pitch. For 
example, a Fine Tuning value of -5 would cause the sound 
to be reproduced five cents flat. 

 

LFO1 Rate Slider 
This slider will allow you to adjust the speed of the rising 
and falling of volume, pitch and filter controlled by the low 
frequency oscillator.  A low frequency oscillator (LFO) is 
what controls these parameters of a sound. 

For those who are interested in a more technical 
description, the LFO1 Rate Slider controls the frequency, in 
absolute cents, of the Modulation LFO’s triangular period. A 
value of zero indicates a frequency of 8.176 Hz. A negative 
value indicates a frequency less than 8.176 Hz; a positive 
value a frequency greater than 8.176 Hz. For example, a 

Using the Pitch 
Coarse Slider 

Using the Pitch 
Fine Slider 

Using the LFO1 
Rate Slider 
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frequency of 10 mHz would be 1200log2(.01/8.176) = -
11610. 

 

LFO1 Filter, Volume and Pitch Sliders 
These sliders will allow you to adjust the amount of filter, 
volume and pitch controlled by the low frequency 
oscillator.  
 
From a technical standpoint, the LFO1 Filter Slider controls 
the degree, in cents, to which a full-scale excursion of the 
Modulation LFO will influence filter cutoff frequency. A 
positive number indicates a positive LFO excursion 
increases cutoff frequency; a negative number indicates a 
positive excursion decreases cutoff frequency. Filter cutoff 
frequency is always modified logarithmically, that is the 
deviation is in cents, semitones, and octaves rather than in 
Hz. For example, a value of 1200 indicates that the cutoff 
frequency will first rise one octave, and then fall one 
octave. 

The LFO1 Volume Slider controls the degree, in centibels, 
to which a full-scale excursion of the Modulation LFO will 
influence volume. A positive number indicates a positive 
LFO excursion increases volume; a negative number 
indicates a positive excursion decreases volume. Volume is 
always modified logarithmically, that is the deviation is in 
decibels rather than in linear amplitude. For example, a 
value of 100 indicates that the volume will first rise ten dB, 
and then fall ten dB. 

The LFO1 Pitch Slider controls the degree, in cents, to 
which a full-scale excursion of the Modulation LFO will 
influence pitch. A positive value indicates a positive LFO 
excursion increases pitch; a negative value indicates a 
positive excursion decreases pitch. Pitch is always modified 
logarithmically, that is the deviation is in cents, semitones, 
and octaves rather than in Hz. For example, a value of 100 
indicates that the pitch will first rise 1 semitone, and then 
fall one semitone. 

 

 

Using the LFO1 
Filter, Volume & 
Pitch Sliders 
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LFO1 Delay Slider 
This slider will allow you to delay when the low frequency 
oscillator begins to effect the sound. 

If you are interested in a more technical description, the 
LFO1 Delay Slider controls the delay time, in absolute time 
cents, from key on until the Modulation LFO begins its 
upward ramp from zero value. A value of 0 indicates a 1 
second delay. A negative value indicates a delay less than 
one second and a positive value a delay longer than one 
second. The most negative number (-32768) 
conventionally indicates no delay. For example, a delay of 
10 msec would be 1200log2(.01) = -7973. 

 

LF02 Rate Slider 
This slider will allow you to adjust the speed of the rising 
and falling of pitch controlled by a second low frequency 
oscillator. 

For the more technically-minded, the LFO2 Rate Slider 
controls the frequency, in absolute cents, of the Vibrato 
LFO’s triangular period. A value of zero indicates a 
frequency of 8.176 Hz. A negative value indicates a 
frequency less than 8.176 Hz; a positive value a frequency 
greater than 8.176 Hz. Sets the frequency (number of 
cycles per second in a waveform) of Vibrato LFO's 
triangular period. 

 

LFO2 Pitch Slider 
This slider will allow you to adjust the amount of pitch 
controlled by the second low frequency oscillator.  This is 
often referred to as vibrato. 

If you are interested in a more technical description, the 
LFO2 Pitch Slider controls the degree, in cents, to which a 
full-scale excursion of the Vibrato LFO will influence pitch. 
A positive value indicates a positive LFO excursion 
increases pitch; a negative value indicates a positive 
excursion decreases pitch. Pitch is always modified 
logarithmically, that is the deviation is in cents, semitones, 
and octaves rather than in Hz. For example, a value of 100 
indicates that the pitch will first rise 1 semitone, then fall 

Using the LFO1 
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one semitone. Sets the degree to which Vibrato LFO will 
influence pitch. If the value is positive, a positive LFO will 
increase pitch.  If the value is negative, a positive LFO will 
decrease pitch. For example, if the value is 100, the pitch 
will first rise 1 semitone at the peak of Vibrato LFO, then 
fall 1 semitone below the original pitch. 

 

LFO2 Delay Slider 
This slider will allow you to delay when the second low 
frequency oscillator begins to affect the sound. 

If you would like a more technical explanation, the LFO2 
Delay Slider controls the delay time, in incriments of 
milliseconds, from key on until the Vibrato LFO begins its 
upward ramp from zero value. A value of 0 indicates a 1 
second delay. A negative value indicates a delay less than 
one second; a positive value a delay longer than one 
second. The most negative number (-32768) 
conventionally indicates no delay. Sets the delay time 
between Note On and the start of the rise towards the 
peak of Vibrato LFO. 

 

Effects A Slider 
The Effects A Slider controls the degree to which the audio 
signals will be sent to the reverb effects processor (which 
adds a sense of spaciousness and ambiance to a sound). 

For the more technically-minded, if the value is 0% or less, 
no signal will be sent.  If the value is 100% or more, the 
note will be sent at full level. For example, a Reverb value 
of 25% indicates that the note will be sent at 25% level to 
the reverb effects processor. 

 

Effects B Slider 
The Effects B Slider controls the degree to which the audio 
signals will be sent to the chorus effects processor. 
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For those who are interested in a more technical 
explanation, if the value is 0%, no signal will be sent.  If 
the value is 100% or more, the note will be sent at full 
level. For example, a Chorus value of 25% indicates that 
the note will be sent at 25% level to the chorus effects 
processor. 

 

The Global Parameters Panel includes the following two 
Envelope Controls: 

§ Volume 
§ Filter and Pitch 
 

An "envelope" is the way in which a particular attribute of 
a sound changes over time.  There are six stages of a 
sound's duration – delay, attack, hold, decay, sustain, and 
release.  In the SoundFont Player, envelopes can be 
applied to Volume, Filter and Pitch.  The following is a 
graphical representation of an envelope: 

 

 

 

 

 

 

Delay represents the amount of time it takes for the 
particular attribute of a sound to be introduced before 
proceeding to the next stage of the envelope.  For 
example, if a Delay of zero seconds is applied to the 
volume of a piano sound, that sound will begin playing 
immediately when you press a key on the keyboard.  If a 
Delay of two seconds is applied to the volume of that same 
piano sound, the sound will begin playing two seconds 
after you press a key on the keyboard. 

In most musical applications, Delay is set to zero because 
you usually want your sound to begin playing immediately.  
There are some instances, however, when you might want 
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a sound to begin playing a certain amount of time after 
you trigger it (through pressing a key on the keyboard, for 
example). 

 

Attack represents the amount of time it takes for the 
particular attribute of a sound to reach its full 
implementation before proceeding to the next stage of the 
envelope.  Using the example of a piano again, if an Attack 
of zero seconds is applied to the volume of the piano 
sound, that sound will reach its highest volume 
(determined by the volume settings of your computer, 
speaker, SoundFont Player, etc.) immediately.  If an 
Attack of three seconds is applied to the volume of that 
same piano sound, the sound will gradually increase to its 
highest volume over a three-second period of time. 

 

Hold represents the amount of time a particular attribute 
of a sound is maintained at the level of its full 
implementation before proceeding to the next stage of the 
envelope.  Continuing with the example of a piano, if a 
Hold of zero seconds is applied to the volume of the piano 
sound, that sound will immediately begin to grow softer 
("decay") after reaching its highest volume.  If a Hold of 
one second is applied to the volume of the piano sound, 
the sound will maintain its highest volume for one second. 

 

Decay represents the amount of time a particular attribute 
of a sound takes to change from the full implementation of 
the Attack and/or Hold stages to the lesser implementation 
set by the Sustain control.  In our piano example, a Decay 
of zero seconds would mean that the sound of the piano, 
after reaching and maintaining its highest volume (in the 
Attack and Hold stages, respectively), would immediately 
change to the level of volume set by the Sustain control.  
If a Decay of five seconds is applied to the volume of the 
piano sound, the volume of that sound would gradually 
decrease over a five second period before reaching the 
Sustain stage of the envelope. 

 

Attack 

Decay 

Hold 
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Sustain represents the level (rather than an amount of 
time as in the other stages of the sound's duration) of a 
sound's parameter at which that sound will stabilize after 
the Decay stage of its life has ended.  For example, if a 
Sustain level of zero decibels is applied to the volume of 
our piano sound, then during the Decay period, the sound 
of the piano will decline to a final volume of zero decibels 
(no sound) at the end of that Decay period.  If a certain 
Sustain level is applied to the volume of our piano sound, 
then during the Decay period, the sound of the piano will 
decline to that Sustain level at the end of that Decay 
period and maintain that volume for as long as the key of 
the keyboard is pressed down. 

 

Release represents the amount of time a particular 
attribute of a sound takes to change from the Sustain level 
to zero.  Continuing with our piano example, if a Release of 
zero seconds is applied to the volume of a piano sound, 
when you stop pressing the key on the keyboard, the 
piano sound will immediately stop playing.  If a Release of 
five seconds is applied to the volume of that same piano 
sound, when you stop pressing the key on the keyboard, 
the piano sound will gradually die out over a five second 
period of time. 

 

Although we have used the volume of a sound for our 
examples because it is perhaps the easiest parameter to 
understand, envelopes can be applied to other 
characteristics of a sound. 

For example, if you want to shift the pitch of a sound over 
its duration, you can easily accomplish this through 
applying an envelope.   

The Filter and Pitch envelope can be manipulated in the 
same way as the Volume envelope.  Keep in mind, 
however, that you will need to adjust the amount of filter 
and/or pitch which is applied by using the Filter and Pitch 
sliders located directly below the Filter and Pitch envelope 
control.  In the case of Filter, you may also need to adjust 
the Filter Fc slider. 

Sustain 

Release 
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Please Note! 
In some cases, envelopes may not seem to function 
correctly because certain presets already have their 
parameters set at a more basic level of the sound.  You 
should also note that when using the envelope controls, 
you are adjusting from a setting already established at the 
preset level.  This means that not all presets will respond 
in the same exact way to the envelope controls – you 
should experiment with each preset to discover the effects 
the envelope controls will have on each particular preset. 

 

The Reset button (located to the right of the envelope 
controls) resets all global parameters to the default 
settings of the active preset. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Using the Reset 
Button 
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You can use the SoundFont Player application to create 
custom, SoundFont-compatible banks using existing 
presets. 

You can either create an entirely new SoundFont bank 
(comprised of existing presets from other SoundFont 
banks), or you can add presets to an already-existing 
SoundFont bank. 

To create an entirely new SoundFont bank, you will need 
to follow these steps: 

1. Select any SoundFont bank from the 
SoundFont Bank list. 

2. When you click on a SoundFont bank in the 
SoundFont Bank list, the presets contained in 
that SoundFont bank will be displayed in the 
SoundFont Preset List – just to the right of the 
SoundFont Bank List in the SoundFont Bank 
Browser panel. 

3. Select one of the presets in the SoundFont 
Preset List by double-clicking on it.  This will 
load that particular preset into your system 
memory, and the preset will appear in the Main 
Preset Window in the Main Panel of the 
SoundFont Player application.  While the preset 
is being loaded into your system memory, you 
may see a notice telling you that the 
SoundFont Player is loading your selected 
preset and asking you to wait. 

4. Repeat Steps 1-3 to add as many SoundFont 
presets as you would like to your new 
SoundFont bank. 

Note: You can add presets with the same name (from 
different banks, of course) to the same SoundFont bank 
because the SoundFont Player will assign presets to 
different Preset IDs.  For the sake of convenience, 
however, you may wish to rename the various presets 
you add.  You can do this by right-clicking on a preset 
name in the Main Preset Window, selecting the Preset 
Settings menu item from the resulting drop-down menu, 
and changing the name of the Preset in the Edit Preset 
Settings dialog box which is opened. 

Creating 
Custom 
SoundFont-
Compatible 
Banks 

Creating a New 
SoundFont-
Compatible 
Bank 

SoundFont-
compatible 
bank: a 
SoundFont-
compatible bank is 
a bank which has 
been created by 
someone other 
than E-MU / 
ENSONIQ or 
Creative.  See 
Appendix C for 
more information. 
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5. When you have finished adding all the presets 
you would like to be included in your new 
SoundFont bank, select the "Save" menu item 
from the File menu. 

6. This will open a dialog box entitled, "Save As". 

7. Choose the location on your hard drive (or zip 
drive or diskette drive) where you would like to 
save your new SoundFont-compatible bank.  
You can change the location by clicking on the 
small downward-pointing arrow on the right 
hand side of the field located to the right of 
"Save in:" in the upper left-hand corner of the 
dialog box.  Then navigate through the file 
structure by clicking on the drive on which you 
wish to place the new SoundFont-compatible 
bank and then double-clicking on folders in the 
main window of the dialog box. 

8. Type in a name for your new bank. 

Note: Do not add the .sf2 extension to the name of your 
bank.  SoundFont Player will do this for you. 

9. Click on the "Save" button to save your new 
bank. 

 

To add presets to an already-existing SoundFont bank, you 
will need to follow these steps: 

1. Double-click on any SoundFont bank in the 
SoundFont Bank. 

2. When you double-click on a SoundFont bank 
in the SoundFont Bank list, the presets 
contained in that SoundFont bank will be 
loaded into your system's memory, and the 
presets will be displayed in the Main Preset 
Window in the Main Panel of the SoundFont 
Player application.  While the presets are 
being loaded into your system memory, you 
may see a notice telling you that the 
SoundFont Player is loading your selected 
presets and asking you to wait. 

Adding Presets 
to an Existing 
SoundFont 
Bank 



SoundFont Player Operation Manual Page 45 

3. To add a preset to the currently-loaded 
SoundFont bank, select any SoundFont bank 
from the SoundFont Bank list contained in the 
SoundFont Bank Browser panel of the 
SoundFont Player. 

4. When you click on a SoundFont bank in the 
SoundFont Bank list, the presets contained in 
that SoundFont bank will be displayed in the 
SoundFont Preset List – just to the right of the 
SoundFont Bank List in the SoundFont Bank 
Browser panel. 

5. Select one of the presets in the SoundFont 
Preset List by double-clicking on it.  This will 
add that particular preset to the currently-
loaded SoundFont bank. 

6. Repeat Steps 3-5 to add as many SoundFont 
presets as you would like to the currently-
loaded SoundFont bank. 

Note: You can add presets with the same name (from 
different banks, of course) to the same SoundFont bank 
because the SoundFont Player will assign presets to 
different Preset IDs.  For the sake of convenience, 
however, you may wish to rename the various presets 
you add.  You can do this by right-clicking on a preset 
name in the Main Preset Window, selecting the Preset 
Settings menu item from the resulting drop-down menu, 
and changing the name of the Preset in the Edit Preset 
Settings dialog box which is opened. 

7. When you have finished adding all the presets 
you would like to be added to the currently-
loaded SoundFont bank, select the "Save" 
menu item from the File menu and your 
edited SoundFont bank will be saved. 
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SoundFont Player can manage and catalog all of your 
SoundFont banks regardless of where they are stored.  
With the catalog feature, you can create a master list of all 
of your SoundFont banks. 

When the SoundFont Player application is launched for the 
first time, the application will catalog all of the SoundFont 
banks on your system (provided that you respond "Yes" to 
the dialog box which asks if you want to create such a new 
catalog). 

If there is no CD in the CD-ROM drive, however, the 
application will not search your CD-ROM drive at a later 
time unless you tell it to do so.  If you place a SoundFont 
CD in your CD-ROM drive (or if you add new SoundFont 
banks to other local drives), you will need to tell the 
application to re-catalog your local drives.  You can do this 
by selecting the "Catalog SoundFont Banks" menu item 
from the File menu. 

When you select this menu item, you will see a dialog box 
which asks if you would like to update your SFPlayer 
browser.  Click on the "Yes" button to proceed to catalog 
your local drives. 

When the cataloging process has finished, the SoundFont 
banks included on your CD (or the new SoundFont banks 
you have added to other local drives) will now appear in 
the SoundFont Bank List in the SoundFont Bank Browser 
Panel. 

Note: If there is a SoundFont CD already in your CD-ROM drive 
the first time you launch the SoundFont Player, and then later 
you insert another SoundFont CD in your CD-ROM drive with the 
SoundFont Player open, the application will automatically ask 
you if you wish to catalog the new banks on the CD. 

 

 

 

 

 

 

Cataloging 
SoundFont 
Banks 

!
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The SoundFont Player application allows you to edit certain 
settings of SoundFont presets and certain properties of 
SoundFont banks located on most of your local drives 
(hard drives, zip drives, diskette drives, etc.).  The settings 
and properties of SoundFont presets and SoundFont banks 
located on CDs cannot, of course, be edited while the 
banks are on the CD.  If you wish to edit the presets and 
properties of such presets and banks, you will need to first 
copy those presets and banks to your hard drive (or a zip 
or diskette drive). 

To edit Preset Settings, you will need to follow these steps: 

1. Select a preset, either from the Main Preset 
Window in the Main Panel or from the 
SoundFont Presets list in the SoundFont Bank 
Browser Panel. 

2. Select the Preset Settings menu item from the 
Edit menu. 

3. This will open a dialog box entitled "Edit 
Preset Settings". 

Within that dialog box, you will be able to 
change the Preset Name, the Bank ID, the 
Preset ID, and also send the preset to the 
percussive pool (drumkit section). 

 

To edit Bank Properties, you will need to follow these 
steps: 

1. Double-click on a SoundFont bank from the 
SoundFont Bank List in the SoundFont Bank 
Browser Panel.  This will load the bank into 
your system's memory.  You can also double-
click on a preset from the SoundFont Preset 
List in the SoundFont Bank Browser Panel 
which will load only the preset into your 
system's memory but will, in effect, create a 
new SoundFont-compatible bank (the bank 
would need to be saved to permanently create 
a new bank). 

Editing 
Settings and 
Properties 

Editing Preset 
Names, ID and 
Type 

Editing Bank 
Properties 
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2. Click on the "Properties" menu item in the File 
menu. 

3. Clicking on this menu item will open a dialog 
box entitled "Properties of ..{Bank Name}" 
with "{Bank Name}" signifying the name of 
the bank whose properties you would like to 
edit. 

Within that dialog box, you will be able to 
change various properties of the currently-
loaded SoundFont bank. 
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 Once you’ve experienced the power that is waiting inside 
your computer to make music as you’ve never before 
dreamed possible, you’ll want to add to your collection of 
musical instruments.   

E-MU / ENSONIQ provides a huge array of professionally 
produced sounds that you can purchase via download or 
on CD at great prices by visiting www.soundfont.com or by 
taking a look at the collection of sounds described below, 
which will get you started on playing any instrument in the 
world (links to specific SoundFont bank collections require 
an active internet connection to function correctly). 

 

 

Module Mania Pop Rock CD  More Info Buy Now! 

Developed from the legendary Proteus® 1 sound 
module, this collection of Pop Rock SoundFont banks 
includes the hottest 256 unique sounds from that 
module, encoded as SoundFont banks for use with your 
SoundFont-compatible audio card!  $29.95 

 
Multimedia Collection CD More Info Buy Now! 

Thirty SoundFont banks which range in size between 
512K and 1.5 MB. Includes Techno, Orchestral, Rock, 
Jazz, and Sound Effects.  This is a great cross-section of 
all the genres available in E-MU's vast SoundFont bank 
library.   $20.00 

 
Guitars, Drums & Synths CD More Info Buy Now! 

A collection of twenty-three 512K SoundFont banks.  If 
you are new to SoundFont technology and are looking 
for some great pop rock sounds, then this is the 
collection for you! It's a great way to "get your feet 
wet!”  $10.00 

 
Developers Choice CD More Info Buy Now! 

Contains all of the 512K banks, as well as 1MB and 2MB 
versions, from the Traditional Voice & Keys CD and the 
Guitars, Drums and Synths CD.   The larger banks give 
you increased flexibility and power and you get all the 
great sounds in one package.  $30.00 

 
 
 
 
 

How to 
Purchase 
More 
SoundFont 
Banks 

Assorted 
Sounds 

http://www.soundfont.com/cds/mmpoprock8.asp
http://www.soundfont.com/cds/multimedia8.asp
http://www.soundfont.com/cds/guitarsdrums8.asp
http://www.soundfont.com/cds/developers8.asp
http://www.soundfont.com/cds/mmpoprock8.asp
http://www.soundfont.com/cds/multimedia8.asp
http://www.soundfont.com/cds/guitarsdrums8.asp
http://www.soundfont.com/cds/developers8.asp
http://www.soundfont.com/BuyEmu/ShopCart.asp?CL=3&CMD=add&PROD=5202
http://www.soundfont.com/BuyEmu/ShopCart.asp?CL=3&CMD=add&PROD=EMU8100-05CD
http://www.soundfont.com/BuyEmu/ShopCart.asp?CL=3&CMD=add&PROD=EMU8100-02CD
http://www.soundfont.com/BuyEmu/ShopCart.asp?CL=3&CMD=add&PROD=EMU8100-01CD
http://www.soundfont.com/new8.html
http://www.soundfont.com/BuyEmu/ShopCart.asp?CL=3&CMD=add&PROD=5202
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500 Bank SoundFont Library CD More Info Buy Now! 

Hundreds of hot new sounds to energize your 
SoundFont-compatible audio card in this new 
millennium!  Five hundred SoundFont banks that make 
up one of the most powerful SoundFont collections on 
the planet!  $19.95 

 
MicroWaveIt CD More Info Buy Now! 

The finest, top quality sounds custom made for you by 
professional musicians. This CD is filled with pure 
musical inspiration in the form of ready-to-load and play 
SoundFont-compatible banks for your SoundFont-
compatible audio card!  $25.00 

 
WaveIt Gold CD More Info Buy Now! 

Never before has one single CD-ROM offered all you 
need to turn your PC into a virtual music studio. WaveIt 
Gold offers a fantastic collection of sounds and tools, 
made especially for you. More than 1000 patches are 
included in SoundFont format.  $59.00 

 
Proteus 1 Pop Rock Download More Info Buy Now! 

From the classic sound module that started it all. This 
SoundFont bank includes the original 128 presets that 
has made Proteus 1 a tradition in the world of MIDI 
controlled sounds. All the basic instruments from pianos 
to drums are included.  $14.95 

 
 
Orchestral Strings Download More Info Buy Now! 

This fantastic 32 megabyte Orchestral Strings 
SoundFont bank is more than just a comprehensive 
collection of orchestral samples. It is truly a virtual 
string orchestra that allows complete flexibility for all 
composers, arrangers, and MIDI performers!  $39.95 

 
Orchestral Winds Download More Info Buy Now! 

This enormous 32 megabyte Orchestral SoundFont bank 
is more than just a comprehensive collection of 
orchestral samples. It is truly a virtual orchestra, 
comprised of woodwinds, brass, percussion and solo 
strings.  $39.95 

 
Module Mania Orchestral CD  More Info Buy Now! 

Developed from the classic Proteus 2 sound module, this 
collection of orchestral SoundFont banks includes the 
hottest 256 unique sounds from that module, encoded 
as SoundFont banks for use with your SoundFont-
compatible audio card!  $29.95 

Orchestral 
Sounds 

http://www.soundfont.com/cds/500banks8.asp
http://www.soundfont.com/cds/microwaveit8.asp
http://www.soundfont.com/cds/waveitgold8.asp
http://www.soundfont.com/cds/mmorchestral8.asp
http://www.soundfont.com/cds/500banks8.asp
http://www.soundfont.com/cds/microwaveit8.asp
http://www.soundfont.com/cds/waveitgold8.asp
http://www.soundfont.com/cds/mmorchestral8.asp
http://www.soundfont.com/downloads/proteus18.asp
http://www.soundfont.com/downloads/OrchestralStrings8.asp
http://www.soundfont.com/downloads/OrchestralWinds8.asp
http://www.soundfont.com/downloads/proteus18.asp
http://www.soundfont.com/downloads/OrchestralStrings8.asp
http://www.soundfont.com/downloads/OrchestralWinds8.asp
http://www.soundfont.com/BuyEmu/ShopCart.asp?CL=3&CMD=add&PROD=5210
http://www.soundfont.com/BuyEmu/ShopCart.asp?CL=3&CMD=add&PROD=5504
http://www.soundfont.com/BuyEmu/ShopCart.asp?CL=3&CMD=add&PROD=8151
http://www.soundfont.com/BuyEmu/ShopCart.asp?CL=3&CMD=add&PROD=5610
http://www.soundfont.com/BuyEmu/ShopCart.asp?CL=3&CMD=add&PROD=5618
http://www.soundfont.com/BuyEmu/ShopCart.asp?CL=3&CMD=add&PROD=5619
http://www.soundfont.com/BuyEmu/ShopCart.asp?CL=3&CMD=add&PROD=5203
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Proteus 2 Download  More Info Buy Now! 

Proteus 2 became the first "Orchestra in a box" that 
gave midi musicians the power to compose using lifelike 
instruments. Television and film scores from around the 
world feature the incredible sounds of the Proteus 2.  
$14.95 

 
Classical Download  More Info Buy Now! 

Xylophone, vibraphone, drum kits, percussion and much 
more! This collection is an incredible value with 15 
different SoundFont-compatible banks! The punchy 
drum kits and percussion alone are worth the price. You 
can't afford to pass up this collection!  $9.95 

 
 
Choir/Strings Download More Info Buy Now! 

2 Choir and 10 String instruments. Whether you are 
doing classical music, scoring for television or feature 
films, or want to sweeten your latest pop tune, this 
wonderful collection brings you professional quality at a 
phenomenal price!  $9.95 

 
 
Brass Download More Info Buy Now! 

A total of 11 Brass instruments including sax, trumpet 
and even tuba! The warm tones of a brass ensemble or 
the sweet sound of a saxophone. High quality brass for 
everything from swinging jazz and punchy pop to 
burning funk!  $9.95 

 
 
Dance Factory Download More Info Buy Now! 

This is one of the most complete SoundFont bank 
collections of essential dance sounds ever assembled!  
Included in this huge 31 megabyte bank are the very 
best sounds and instruments required to produce house, 
techno, and dance music.  $39.95 

 
Pure Phatt Download More Info Buy Now! 

This is one of the most complete SoundFont collections 
of essential hip-hop sounds ever assembled! Included in 
this massive 28 megabyte bank are the very best 
sounds and instruments used in the Mo'Phatt sound 
module!  $39.95 
 
 
 
 

 

Vocal & Strings 
Sounds 

Brass Sounds 

Dance/Techno 
Sounds 

http://www.soundfont.com/downloads/proteus28.asp
http://www.soundfont.com/downloads/mzone_classical8.asp
http://www.soundfont.com/downloads/mzone_strings8.asp
http://www.soundfont.com/downloads/mzone_brass8.asp
http://www.soundfont.com/downloads/DanceFactory8.asp
http://www.soundfont.com/downloads/PurePhatt8.asp
http://www.soundfont.com/downloads/proteus28.asp
http://www.soundfont.com/downloads/mzone_classical8.asp
http://www.soundfont.com/downloads/mzone_strings8.asp
http://www.soundfont.com/downloads/mzone_brass8.asp
http://www.soundfont.com/downloads/DanceFactory8.asp
http://www.soundfont.com/downloads/PurePhatt8.asp
http://www.soundfont.com/BuyEmu/ShopCart.asp?CL=3&CMD=add&PROD=5611
http://www.soundfont.com/BuyEmu/ShopCart.asp?CL=3&CMD=add&PROD=8163
http://www.soundfont.com/BuyEmu/ShopCart.asp?CL=3&CMD=add&PROD=8162
http://www.soundfont.com/BuyEmu/ShopCart.asp?CL=3&CMD=add&PROD=8161
http://www.soundfont.com/BuyEmu/ShopCart.asp?CL=3&CMD=add&PROD=5617
http://www.soundfont.com/BuyEmu/ShopCart.asp?CL=3&CMD=add&PROD=5620
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Module Mania Hip-Hop/Urban CD  More Info Buy Now! 

Developed from the slammin’ Planet Phatt sound 
module, this collection of Hip-Hop/Urban SoundFont 
banks includes the hottest 256 unique sounds from that 
module, encoded as SoundFont banks for use with your 
SoundFont-compatible audio card!  $29.95 

 
Phatt Beats SoundFont CD  More Info Buy Now! 

This CD contains a vast assortment of Hip Hop and R&B 
rhythms from today’s top artists.  Now for the first time, 
these beats are available as SoundFont banks, opening 
up a whole world of new sounds by applying the features 
of the SoundFont format!  $19.95 

 
Orbit The Dance Planet Download  More Info Buy Now! 

This bank features cutting edge sounds from E-MU’s 
popular Orbit The Dance Planet™ module, sounds that 
will drive the dance floor all night long!  Sub sonic 
basses, chord hits, synth pads, and killer kits will take 
your music into the next dimension!  $14.95 

 
Planet Phatt Download  More Info Buy Now! 

The ultimate sound set for Hip Hop, Rap, and R&B!  
Basses, drum kits, guitar and vocal hits direct from 
today’s top artists.  Your music will be filled with 
fashionable sounds that will make you the star.  This 
SoundFont bank is groove ready!  $14.95 

 
 
Basses Download More Info Buy Now! 

4 Electric/acoustic basses, 9 Synth basses. The right 
bass sound can be the essential part of any music. This 
collection of suburb basses, taken from the Micro 
WaveIt! CD ROM gives you the bottom you need, with 
no compromises!  $9.95 

 
Guitars Download  More Info Buy Now! 

8 Guitars ranging from nylon to heavy electric. Not just 
rock music needs a good guitar and this collection has 
guitars for all kinds of music. Every guitar you'll need for 
anything from flamenco to heavy metal is right here!  
$9.95 

 
 
 
 
 
 
 
 

Guitar Sounds 

http://www.soundfont.com/cds/mmhiphop8.asp
http://www.soundfont.com/cds/phattbeatssf8.asp
http://www.soundfont.com/cds/mmhiphop8.asp
http://www.soundfont.com/cds/phattbeatssf8.asp
http://www.soundfont.com/downloads/orbit8.asp
http://www.soundfont.com/downloads/phatt8.asp
http://www.soundfont.com/downloads/mzone_basses8.asp
http://www.soundfont.com/downloads/mzone_guitars8.asp
http://www.soundfont.com/downloads/orbit8.asp
http://www.soundfont.com/downloads/phatt8.asp
http://www.soundfont.com/downloads/mzone_basses8.asp
http://www.soundfont.com/downloads/mzone_guitars8.asp
http://www.soundfont.com/BuyEmu/ShopCart.asp?CL=3&CMD=add&PROD=5200
http://www.soundfont.com/BuyEmu/ShopCart.asp?CL=3&CMD=add&PROD=5212
http://www.soundfont.com/BuyEmu/ShopCart.asp?CL=3&CMD=add&PROD=5614
http://www.soundfont.com/BuyEmu/ShopCart.asp?CL=3&CMD=add&PROD=5616
http://www.soundfont.com/BuyEmu/ShopCart.asp?CL=3&CMD=add&PROD=8160
http://www.soundfont.com/BuyEmu/ShopCart.asp?CL=3&CMD=add&PROD=8164
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MicroWaveIt Piano CD More Info Buy Now! 

MicroWaveIt Piano is a great SoundFont-compatible 
bank collection. Bringing you the finest sounds from a 
whole range of Pianos including unbelievable Grand 
Pianos, Rhodes, Wurlitzers and more.  If you're looking 
for great piano sounds, look no further! $29.00 

 
8mb Grand Download More Info Buy Now! 

The Ultimate Grand Piano SoundFont-compatible bank! 
A massive 8mb of pure piano heaven. No matter what 
music you write, or whether you just want to enjoy 
those beautiful piano MIDI's, this SoundFont-compatible 
bank is for you.  $14.95 

 
2x4mb Grand Bosendorfer Download More Info Buy Now! 

This package from Sonido Media gives you great 
versatility with a beautiful sounding Grand Piano and an 
aggressive and powerful sounding Bosendorfer piano. 
Both banks are velocity sensitive to provide unmatched 
realism.  $9.95 

 
Yamaha Piano Download More Info Buy Now! 

Featuring two 4 megabyte Yamaha Pianos. The Yamaha 
C5 is majestic and elegant. The Yamaha CFIII is just 
plain beautiful. If you're longing for the sounds of 
Yamaha pianos, you can't go wrong with this bank!  
$9.95 

 
Church Organ Download More Info Buy Now! 

Have you ever noticed that the church organs in typical 
General MIDI sound sets are just a little bit thin? The 
organs in this pack will make you think you're standing 
in a Cathedral! You won't believe such huge sounds 
could come out of your PC.  $9.95 

 
Hammond B3 Download More Info Buy Now! 

The Hammond B3 is a staple for styles of music ranging 
from Rock to Gospel – it has been around since the 
1960's but still sounds fresh today. You get four 
different B3 sounds, including the trademark Leslie 
speaker sound!  $9.95 

 
Keys Download More Info Buy Now! 

A few years ago if you wanted to use a B3, a Rhodes, a 
grand piano and a DX-7, you'd need two trucks, four 
roadies and a lot of insurance. Now you can download all 
these instruments in minutes for a fraction of the cost 
and far less back strain!  $9.95 

 

Keyboard 
Sounds 

http://www.soundfont.com/cds/microwaveitpiano8.asp
http://www.soundfont.com/cds/microwaveitpiano8.asp
http://www.soundfont.com/downloads/sonido_grand8.asp
http://www.soundfont.com/downloads/sonido_bosendorfer8.asp
http://www.soundfont.com/downloads/sonido_yamaha8.asp
http://www.soundfont.com/downloads/sonido_churchorgan8.asp
http://www.soundfont.com/downloads/sonido_hammond8.asp
http://www.soundfont.com/downloads/mzone_keys8.asp
http://www.soundfont.com/downloads/sonido_grand8.asp
http://www.soundfont.com/downloads/sonido_bosendorfer8.asp
http://www.soundfont.com/downloads/sonido_yamaha8.asp
http://www.soundfont.com/downloads/sonido_churchorgan8.asp
http://www.soundfont.com/downloads/sonido_hammond8.asp
http://www.soundfont.com/downloads/mzone_keys8.asp
http://www.soundfont.com/BuyEmu/ShopCart.asp?CL=3&CMD=add&PROD=8150
http://www.soundfont.com/BuyEmu/ShopCart.asp?CL=3&CMD=add&PROD=8133
http://www.soundfont.com/BuyEmu/ShopCart.asp?CL=3&CMD=add&PROD=8134
http://www.soundfont.com/BuyEmu/ShopCart.asp?CL=3&CMD=add&PROD=8135
http://www.soundfont.com/BuyEmu/ShopCart.asp?CL=3&CMD=add&PROD=8137
http://www.soundfont.com/BuyEmu/ShopCart.asp?CL=3&CMD=add&PROD=8139
http://www.soundfont.com/BuyEmu/ShopCart.asp?CL=3&CMD=add&PROD=8165
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Electric Piano Download More Info Buy Now! 

Featuring a ravishing Rhodes, a wonderful Wurlitzer, an 
oh-so-good OB-8, and a fantastic Funk piano! These 
electric piano SoundFont-compatible banks are a MUST 
for any pop, funk, jazz, or new age music creations.  
$9.95 

 
 
Millennium Synths CD  More Info Buy Now! 

A collection of some of the most revolutionary 
synthesizer sounds available. This CD offers you 
everything from subsonic woofer-rumbles to full 
spectrum soundscapes to edgy tweeter-tweakers. 
$29.95 

 
The Moog Collection Download More Info Buy Now! 

Thinking back to the good old days when analog synths 
were in? Well guess what, they're back! This collection 
gives you the best of Moogs, the Memory Moog, the Mini 
Moog, the Moog Prodigy, and the Moog Rogue, all in 
SoundFont-compatible format!  $9.95 

 
Roland Download More Info Buy Now! 

This is part 1 of 2 from Sonido Media's collection of 
venerable Roland synths. You get the synth drums of 
the TR606, the trademark fat analog sounds of the JX-
3P, JX-8P and the Jupiter8 as well as bass and solo 
sounds from the SH101.  $9.95 

 
Sequential Download More Info Buy Now! 

Thinking back to the good old days when analog synths 
were in? They’re back! Except these SoundFont-
compatible banks weigh about zero pounds! This 
collection includes the Sequential Prophet T8, Prophet 
VS, Drumtracks, and Pro-One.  $9.95 

 
Oberheim Download More Info Buy Now! 

Jam-packed with professional crisp samples, you'll be 
overwhelmed with the possibilities! This collection gives 
you thick Oberheim Matrix-12 patches dripping with 
modulation. The classic sounds of the OB-8 and OB-XA 
are also included.  $9.95 

 
Synthesizers Download More Info Buy Now! 

15 Unique Synth Sounds! These amazing sounds, taken 
from the most famous synthesizers around the globe, 
sound bigger than your wildest dreams! This collection 
in SoundFont-compatible format is a must for anyone 
who loves synth sounds.  $9.95 

Synth Sounds 

http://www.soundfont.com/cds/msynthssf8.asp
http://www.soundfont.com/cds/msynthssf8.asp
http://www.soundfont.com/downloads/sonido_electricpiano8.asp
http://www.soundfont.com/downloads/sonido_moog8.asp
http://www.soundfont.com/downloads/sonido_roland8.asp
http://www.soundfont.com/downloads/sonido_sequential8.asp
http://www.soundfont.com/downloads/sonido_oberheim8.asp
http://www.soundfont.com/downloads/mzone_synths8.asp
http://www.soundfont.com/downloads/sonido_electricpiano8.asp
http://www.soundfont.com/downloads/sonido_moog8.asp
http://www.soundfont.com/downloads/sonido_roland8.asp
http://www.soundfont.com/downloads/sonido_sequential8.asp
http://www.soundfont.com/downloads/sonido_oberheim8.asp
http://www.soundfont.com/downloads/mzone_synths8.asp
http://www.soundfont.com/BuyEmu/ShopCart.asp?CL=3&CMD=add&PROD=8136
http://www.soundfont.com/BuyEmu/ShopCart.asp?CL=3&CMD=add&PROD=8140
http://www.soundfont.com/BuyEmu/ShopCart.asp?CL=3&CMD=add&PROD=5213
http://www.soundfont.com/BuyEmu/ShopCart.asp?CL=3&CMD=add&PROD=8141
http://www.soundfont.com/BuyEmu/ShopCart.asp?CL=3&CMD=add&PROD=8143
http://www.soundfont.com/BuyEmu/ShopCart.asp?CL=3&CMD=add&PROD=8144
http://www.soundfont.com/BuyEmu/ShopCart.asp?CL=3&CMD=add&PROD=8166
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Old World Instruments Download More Info Buy Now! 

This massive SoundFont bank is one of the most 
complete collections of essential old world instruments 
ever assembled! Included are the very best sounds and 
instruments used in E-MU's popular Planet Earth sound 
module. $39.95 

 
Module Mania World Instruments CD More Info Buy Now! 

Developed from the classic Proteus 3 sound module, this 
collection of World SoundFont banks includes the hottest 
256 unique sounds from that module, encoded as 
SoundFont banks for use with your SoundFont-
compatible audio card!  $29.95 

 
Gamelan Balinese Orchestra CD More Info Buy Now! 

This CD features Gamelan, an Indonesian Orchestra 
composed primarily of percussion instruments such as 
xylophones, gongs and drums. This is an amazing 
complete set of SoundFont banks for composing and 
studying the exquisite sound of Gamelan.  $19.95 

 
Chinese Orchestra CD More Info Buy Now! 

This is an amazing collection for composing exquisite 
oriental music and sounds. The SoundFont banks on this 
CD are from selected Chinese musical instruments that 
encompass wind, bowed string, plucked string, and 
percussion instruments.   $19.95 

 
Proteus 3 World Download More Info Buy Now! 

The third in a series of MIDI sound modules, Proteus 3 
covers a large selection of instruments from around the 
world. This bank includes Waterphones, Shofars, Koto, 
and much more. These original presets will take you to 
the ends of the earth!  $14.95 

 
 
Module Mania Vintage Instruments CD More Info Buy Now! 

Developed from the wonderful Vintage Keys sound 
module, this collection of Vintage SoundFont banks 
includes the hottest 256 unique sounds from that 
module, encoded as SoundFont banks for use with your 
SoundFont-compatible audio card!  $29.95 
 
 
 
 
 
 
 

 

World Sounds 

Vintage Sounds 

http://www.soundfont.com/cds/mmworld8.asp
http://www.soundfont.com/cds/gamelan8.asp
http://www.soundfont.com/cds/chinese8.asp
http://www.soundfont.com/cds/mmvintage8.asp
http://www.soundfont.com/cds/mmworld8.asp
http://www.soundfont.com/cds/gamelan8.asp
http://www.soundfont.com/cds/chinese8.asp
http://www.soundfont.com/cds/mmvintage8.asp
http://www.soundfont.com/downloads/OldWorld8.asp
http://www.soundfont.com/downloads/proteus38.asp
http://www.soundfont.com/downloads/OldWorld8.asp
http://www.soundfont.com/downloads/proteus38.asp
http://www.soundfont.com/BuyEmu/ShopCart.asp?CL=3&CMD=add&PROD=5621
http://www.soundfont.com/BuyEmu/ShopCart.asp?CL=3&CMD=add&PROD=5204
http://www.soundfont.com/BuyEmu/ShopCart.asp?CL=3&CMD=add&PROD=5215
http://www.soundfont.com/BuyEmu/ShopCart.asp?CL=3&CMD=add&PROD=5214
http://www.soundfont.com/BuyEmu/ShopCart.asp?CL=3&CMD=add&PROD=5612
http://www.soundfont.com/BuyEmu/ShopCart.asp?CL=3&CMD=add&PROD=5201
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Vintage Keys Download More Info Buy Now! 

Electronic keyboards went through an evolution in the 
60's, 70's & 80's. Today, many of these vintage 
keyboards are sought after for the warm tones they 
create. This bank features many analog synthesizers, 
electric pianos, organs, and guitars.  $14.95 

 
 
Hollywood Sound Effects CD More Info Buy Now! 

This CD contains a vast assortment of sound effects 
from the library of noted Hollywood sound effects guru 
Frank Serafine. Now for the first time, these classic 
sounds are available as SoundFont Banks.  Don't miss 
this wonderful collection!  $29.95 

 
 
General MIDI CD More Info Buy Now! 

The General MIDI Collection includes banks which range 
in size between two and eight megabytes. This CD can 
replace your original General MIDI Bank with much 
better quality sound. 2 MB, 4MB, and 8MB banks are 
included.  $20.00 

 
Jan Hammer Download More Info Buy Now! 

This bundle contains a custom 8 megabyte General MIDI 
sound set (in SoundFont format) from Voice Crystal and 
E-MU / ENSONIQ and an original MIDI file composition 
from keyboard legend Jan Hammer.  This is a wonderful 
General MIDI bank!  $9.95 

 
 
Woodwinds Download More Info Buy Now! 

11 Wind instruments from bass clarinet to flute to a 
glass bottle. The full range of woodwinds is accounted 
for here. Bass clarinet, Clarinet, English horn, Oboe, 
Flute, Piccolo and Ocarina. This collection perfectly 
captures these wonderful instruments.  $9.95 

 
 
Module Mania CD Bundle More Info Buy Now! 

The five Module Mania CDs (Hip-Hop/Urban, Vintage 
Instruments, Pop Rock, Orchestral, and World 
Instruments) in one bundle, offered at a phenomenal 
savings of nearly $50.00 over the price you would pay if 
you bought each CD separately!  $99.95 
 
 
 

 
 

Sound Effects 

General MIDI 
Sounds 

Woodwind 
Sounds 

Special Bundle 

http://www.soundfont.com/cds/hwood8.asp
http://www.soundfont.com/cds/generalmidi8.asp
http://www.soundfont.com/cds/mmbundle8.asp
http://www.soundfont.com/cds/hwood8.asp
http://www.soundfont.com/cds/generalmidi8.asp
http://www.soundfont.com/cds/mmbundle8.asp
http://www.soundfont.com/downloads/vintage8.asp
http://www.soundfont.com/downloads/jhammer8.asp
http://www.soundfont.com/downloads/mzone_woodwinds8.asp
http://www.soundfont.com/downloads/vintagekeys8.asp
http://www.soundfont.com/downloads/vintagekeys8.asp
http://www.soundfont.com/downloads/jhammer8.asp
http://www.soundfont.com/downloads/mzone_woodwinds8.asp
http://www.soundfont.com/BuyEmu/ShopCart.asp?CL=3&CMD=add&PROD=5613
http://www.soundfont.com/BuyEmu/ShopCart.asp?CL=3&CMD=add&PROD=5211
http://www.soundfont.com/BuyEmu/ShopCart.asp?CL=3&CMD=add&PROD=EMU8100-04CD
http://www.soundfont.com/BuyEmu/ShopCart.asp?CL=3&CMD=add&PROD=8600
http://www.soundfont.com/BuyEmu/ShopCart.asp?CL=3&CMD=add&PROD=8167
http://www.soundfont.com/BuyEmu/ShopCart.asp?CL=3&CMD=add&PROD=5205
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The SoundFont Player has a comprehensive online help 
system, patterned after this manual to make it as easy as 
possible for you to receive the help you need in using the 
application. 

To access the help system, select the Help Topics menu 
item from the Help menu. 

You can also click the "Help" button in certain dialog 
boxes.   

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Using the 
Help System 
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If you experience problems with SoundFont Player, please 
contact Creative Labs' technical support department as 
follows: 

Visit our online help websites for help with installation, 
answers to frequently asked questions, or troubleshooting 
tips.  Our websites hold a wealth of information as well as 
up-to-the-minute software and driver upgrades: 

 http://www.americas.creative.com/support 

 

BEFORE YOU CONTACT TECHNICAL SUPPORT 

Please fill out the following information and be seated at 
your computer. 

Model #:  E-MU / ENSONIQ SoundFont Player 
     
The text of any error message on the screen 
and how it came about: 
 
    
 
    
 
 
Information on the adapter card that conflicts 
with the product (if applicable): 
 

     
 
     

 
 
Hardware configuration information: 
 

     
 

    
 
 
 
 

Technical 
Support 

http://www.americas.creative.com/support
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Computer type and speed: 
 

     
 

    
 
 
Type and version of your operating system - 
Windows 95/98/Me/NT/2000: 
 

     
 

    
 

 
For comments or questions regarding our technical 
support, you can also contact us at the following address:  
Creative Labs, Inc., Technical Support, 1523 Cimarron 
Plaza, Stillwater, OK 74075. 

If after consulting our online help, you still have a support 
question regarding SoundFont Player, you may contact us 
at the following number (please have your system 
hardware and operating system configuration information 
available for the call):  Telephone (+1) 405-742-6622. 
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To learn more about the E-MU / ENSONIQ SoundFont 
Player, cool new SoundFont banks, and other desktop 
music software, be sure to visit our SoundFont technology 
website at http://www.soundfont.com.   

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

For More 
Information 

http://www.soundfont.com/new8.html
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When you first download the SoundFont Player application, you will 
receive it in the form of a compressed file with a .zip extension 
(5223.zip).  In addition, SoundFont banks purchased via download 
from SoundFont.com will also be received in the form of compressed 
files with .zip extensions (e.g., 5610.zip). 

In order to decompress these files, you will need a zip utility.  We 
recommend that you use an application called WinZip, but there are 
many other zip utilities available at various software repositories on 
the World Wide Web. 

It is very important that you write down the location of the directory or 
folder into which you will download the 5223.zip file. 

The following steps describe the procedure which you should employ 
to decompress the 5223.zip file (as well as any other .zip files you 
obtain from SoundFont.com):  

1. With your internet connection active, enter 
http://www.winzip.com into the address bar of your 
browser and press the Enter or Return key on your 
keyboard.  

2. Once you arrive at http://www.winzip.com, click on the 
words "Download 8.0 Evaluation Version". 

Note: At the time this manual was written, the current 
version of WinZip was 8.0.  This version number will 
almost certainly change in the future – you should 
download the most recent evaluation version. 

3. This will take you to a new page entitled "Winzip - 
Download Evaluation Page".  

4. On that page, click on the link which says "Download 
WinZip 8.0 for Windows 95/98/NT/2000/Me (winzip 
80.exe – 1,259,960 bytes) from a WinZip download 
server". This will take you to another new page and the 
download process will begin automatically.  

5. You may see a dialog box which asks if you want to 
open or save the file.  Click on the "Save" button. 

6. You will then be presented with a dialog box with the 
title "Save As...."  

7. Near the top of the dialog box, you will see the text 
"Save in:" and a drag down box with the name of one of 
the directories on your hard drive. We would 
recommend that you do not change this directory, but 
make sure you write down its name and location (you 
can discover its location in your directory structure by 
clicking once on the downward-pointing arrow at the 

Appendix A: 
Using 
WinZip 

http://www.winzip.com
http://www.winzip.com
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right of the drag down box -- click on that arrow again 
to close the directory structure). It is very important 
that you write down the name and location of the 
directory into which you download the file!!!  

8. Click on the "OK" button within the dialog box and the 
download will begin (as of the date of these instructions, 
you will be downloading a file called winzip80.exe).  

9. Upon clicking the "OK" button, the "Save As...." dialog 
box will close and you will see a progress meter appear 
on your screen entitled "Saving Location" -- wait until 
this progress meter finishes and closes.  

10. Click on the "Start" button in the lower left hand portion 
of your screen and drag your cursor up to the "Run...." 
item. Click on the "Run...." item.  

11. Another dialog box (this time entitled appropriately 
"Run") will open.  

12. Click the "Browse" button. This will open another dialog 
box entitled "Browse".  

13. Now you must find the winzip80.exe file by moving 
through your directory structure in the main window of 
the "Browse" dialog box.  

14. Once you find the winzip80.exe file, double click on it.  

15. This will return you to the "Run" dialog box and the 
winzip80.exe (and the path to it) will appear in the main 
blank of the "Run" dialog box.  

16. Click on the "OK" button in the "Run" dialog box and the 
installation of WinZip 8.0 will begin. Follow the on-
screen instructions to complete the installation of WinZip 
8.0.  

17. Once the installation of WinZip 8.0 is complete, click on 
the "Start" button in the lower left hand portion of your 
screen and drag your cursor up to the "Programs" item 
and over to the right to the WinZip item and once more 
over to the right to the WinZip 8.0 item. Click on the 
WinZip 8.0 item. The WinZip 8.0 program will begin.  

18. Since what you have downloaded is a trial (or 
evaluation) version of WinZip 8.0, you will notice one or 
more "nag" screens asking you to pay for a registered 
version. You can either choose to pay for the registered 
version now or you can wait up to 30 days and still 
legally use the trial version.  
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19. Once you have made your way through the "nag" 
screens, you will see a dialog box called WinZip 
(Unregistered).  

20. Within that dialog box, click on the "Open" button  

21. Another dialog box will appear entitled "Open Archive" -- 
you can then browse through your directories until you 
find the SoundFont Player compressed file (5223.zip) 
you earlier downloaded (or the file name of any 
compressed SoundFont bank you have purchased).  

22. When you find the 5223.zip file (or the compressed file 
of any SoundFont bank you have purchased), double-
click on it. This will return you to the "WinZip 
(Unregistered)" dialog box, but you will now see the 
SoundFont Player installation files in the main window of 
that dialog box.  

23. Click on the "Extract" button -- this will open an 
additional dialog box entitled appropriately "Extract".  

24. Your directory structure will appear in the main window 
(on the right) of this dialog box. Find the directory in 
which you want to place the decompressed SoundFont 
Player installation files and click on it. The path to that 
directory should now appear in the blank (near the left 
and top of the dialog box) labelled "Extract to:"  

25. Very Important: Write down the name and 
location into which you will decompress the 
SoundFont Player installation files. 

26. Make sure the "All files" radio button is selected and 
click on the "Extract" button. This will return you to the 
"WinZip (Unregistered)" dialog box and the 
decompression process will begin (it often only takes a 
couple of seconds, so you may not even notice the 
progress meter at the bottom right of the dialog box).  

27. Your decompressed SoundFont Player installation files 
will now be in the directory you selected in step 24. 

28. Once you have decompressed the SoundFont Player 
installation files, you can proceed with the installation of 
the SoundFont Player as described in the section of this 
manual entitled, "Installation Instructions" in the 
Introduction chapter. 
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Many people will find the most enjoyment in using the SoundFont 
Player if they first connect an external MIDI keyboard to their 
computer.  This is generally a very simple process.  This appendix is 
designed to help you connect either of two different categories of 
external MIDI keyboards to your computer equipped with a Sound 
Blaster Audigy or Sound Blaster Live! audio card. 

 

If you have a BlasterKey MP3 external keyboard and have not yet 
connected it, please follow these steps to connect your keyboard to 
your computer: 

1. Your BlasterKey MP3 comes with a cable which is 
designed to connect your BlasterKey MP3 to the joystick 
port on your Sound Blaster Audigy or Sound Blaster 
Live! audio card. 

2. Connect one end of that cable to the MIDI Port on the 
back of your BlasterKey MP3 keyboard. 

3. Connect the other end of the cable to the joystick port 
on your Sound Blaster Audigy or Sound Blaster Live! 
audio card. 

4. Install your BlasterKey MP3 software, following the 
instructions included in your BlasterKey MP3 manual. 

 

If you have an external MIDI keyboard which is not a BlasterKey MP3 
keyboard, it is still quite simple to connect the keyboard to your 
computer.  You will need a MIDI adapter to connect your keyboard.  If 
you do not have one, you can buy one directly from Creative Labs' 
shopping websites: 

In the Americas: 
http://www.americas.creative.com/shop/ 

In Europe: 
http://www.europe.creative.com/estore/ 
 
In Asia: 
http://www.blastershop.com/ 
 

Or, you can purchase one from your local music or computer store, as 
well as from various other online stores. 

To connect your external MIDI keyboard to your computer, please 
follow these steps: 

1. Connect the MIDI In connector of your MIDI adapter 
(one of the "round" connectors – it should be labelled 

Appendix B: 
Connecting 
an External 
MIDI 
Keyboard 

Connecting a 
BlasterKey MP3 
Keyboard to 
your Computer 

Connecting an 
External MIDI 
Keyboard to 
your Computer 
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http://www.blastershop.com/
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"IN") to the MIDI Out connector of your external MIDI 
keyboard. 

2. Connect the "MIDI Cable" end of your MIDI adapter to 
the joystick port of your Sound Blaster Audigy or Sound 
Blaster Live! audio card. 
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SoundFont and the SoundFont logo are registered trademarks of E-mu 
Systems, Inc. Recently, we've noticed that some folks have been 
incorrectly using our marks.  

Although it would be nice to ignore this misuse, unfortunately we 
can't. Sometimes it seems silly to have to run around telling people 
how they can and cannot use certain words. It's tempting to think we 
have better things to do.  

Trademark Law 
According to trademark law, it is necessary for the owner of a 
trademark to ensure that the trademark is not misused by itself or 
other parties. Failure to ensure proper usage may result in the 
trademark becoming generic. When a word which was formerly a 
trademark comes to signify to the general public the kind of product or 
service it names rather than representing a particular brand of that 
product or service, it becomes generic.  

Words such as "thermos," "escalator," "aspirin," "trampoline," 
"cellophane," and "linoleum" were all once names of specific products 
sold by specific companies. Because those companies were not vigilant 
in ensuring that their trademarks were correctly used, these words 
became generic and were no longer considered trademarks of the 
specific companies.  

So what's the big deal? They are only names, right? Not entirely.  

Trademarks Are A Distinguishing Factor 
Trademarks are vehicles by which companies can distinguish their 
products from competitors' products. When the moving stairway 
manufactured by the Otis Elevator Company was called the "Escalator" 
moving stairway, and the Otis Elevator Company owned the 
"Escalator" trademark, they could legitimately say "There is only one 
Escalator moving stairway." It served as a way of distinguishing their 
moving stairway from those of their competitors.  

Similarly, because E-mu Systems, Inc. owns the "SoundFont" 
trademark, we are able to distinguish our sound technology from that 
of our competitors. However, if the SoundFont trademark becomes 
generic, we would lose our ability to distinguish our unique brand of 
products (this was the fate of Otis Elevator Company's escalator 
trademark).  

Why Should You Care? 
Protecting our trademarks ensures that only products which conform 
to the official SoundFont specification can be called SoundFont-
compatible. If we were to allow the "SoundFont" trademark to become 
generic, we would no longer be able to distinguish our sound banks 
and SoundFont-compatible sound banks developed by third-party 
developers from sound banks which do not conform to the SoundFont 
specification. Anyone who created a sound bank, whether or not it 
conformed to the SoundFont specification, would be able to say that 
their sound bank was a "SoundFont" (actually, calling a sound bank "a 

Appendix C: 
A Word 
About 
Terminology 
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SoundFont" or a group of sound banks "SoundFonts" are misuses of 
the trademark as well - more on that in a moment).  

If that were to occur, then there could potentially be a situation in 
which you, the consumer wanting to buy a sound bank which would 
function correctly with your Sound Blaster Audigy, Sound Blaster Live! 
or E-MU Audio Production Studio, would not know which bank to 
purchase - you wouldn't be sure that anything termed a "SoundFont" 
would function correctly with what we know today as SoundFont-
compatible audio cards.  

Do you see how this could be frustrating for you, our customer? You 
wouldn't know if what someone called a "SoundFont" would function 
correctly with your sound card, because everyone would be be able to 
call their sound banks "SoundFonts." Such a situation could potentially 
be very frustrating for you. While we would certainly prefer to continue 
owning our trademark, the larger issue is really your satisfaction - if 
you, as our customer, are frustrated because you purchase what 
someone calls a "SoundFont" but it doesn't function correctly with your 
sound card because, in reality, it wasn't  

SoundFont-compatible, then we have failed to serve you as our 
customer by ensuring that you receive accurate information. We would 
obviously prefer that this not happen, and we hope you agree.  

How You Can Help 
There are four main areas in which you, as our customers, can help us 
protect the "SoundFont" trademark (at the end of this article, we have 
appended some information about what to do if you are not doing 
these things and can't, in effect, turn back the clock):  

Always use "SoundFont" as an adjective. This means that calling a 
sound bank "a SoundFont" or a group of sound banks "SoundFonts" 
are misuses of the trademark. The proper way to use the trademark is 
to call those sound banks "SoundFont banks," "SoundFont-compatible 
banks," "SoundFont files" or "SoundFont samples." It is also 
appropriate to refer to "SoundFont technology" and/or "SoundFont 
libraries."  

Always refer to your own creations as "SoundFont-compatible" banks. 
Technically, only E-mu Systems, Inc. and other members of the 
Creative Technology family of companies can legally refer to their 
creations as "SoundFont banks." Perhaps the most common misuse 
along these lines is to speak of "creating your own SoundFont bank." 
Technically speaking, only employees of E-MU / ENSONIQ and other 
members of the Creative Technology family of companies can create 
"their own SoundFont bank." Everyone else is creating "SoundFont-
compatible banks."  

Do not use the "SoundFont" trademark within your domain name. Any 
appearance of "SoundFont" within the second level domain is a misuse 
of the trademark. For example, "www.soundfontavenue.com" is a 
violation of E-mu Systems' trademark rights. Of course, using 
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trademarks in the names of website subdirectories, such as 
"www.whatever.com/soundfont.html" is accepted practice and we have 
no problem with that.  

Always use the appropriate trademark symbols and legends as follows: 
The first or most prominent use of the "SoundFont" trademark on a 
website, in an advertisement, or on product packaging should be 
immediately followed by the ® symbol, as follows: "SoundFont®-
compatible banks." At the bottom of the page or package on which the 
first use appears, there should be a trademark legend (or a direct link 
to a legend) which includes the following statement: "SoundFont is a 
registered trademark of E-mu Systems, Inc. in the United States of 
America and/or other countries." If you also use the SoundFont logo, 
the statement should read "SoundFont and the SoundFont logo are 
registered trademarks of E-mu Systems, Inc. registered in the United 
States of America and/or other countries."  

Uh Oh .... We Have A Problem 
What should you do if you now realize that you have misused the 
"SoundFont" trademark but it is not easy to "turn back the clock" and 
correct the problem, as it were? Don't worry - in general, all we are 
asking is that you stop misusing the trademark on a going-forward 
basis.  

For example, if you are a SoundFont technology developer and the 
packaging used for some physical product you have developed uses 
the word "SoundFonts" or you did not call your creations "SoundFont-
compatible banks," we don't expect you to withdraw product from the 
market and correct the problem. What we do ask is, at the time of 
your next run of product, that you please correct the misuses.  

What should you do if you are using the term "SoundFont" within your 
second-level domain (such as ""www.soundfontavenue.com")? If this 
is the case, please email us at your earliest convenience so we can 
discuss how to resolve the issue.  

Thanks for helping us make SoundFont technology the best sound 
format on the planet and for helping us ensure that you and other 
customers will be able to purchase SoundFont products without the 
fear that they will not function properly! 
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Please read this warranty, as it gives you specific 
legal rights. 

E-MU / ENSONIQ warrants the compact disc on which the Software is 
recorded (provided you obtained the software on a compact disc rather 
than via download) to be free from defects in materials and 
workmanship under normal use for a period of ninety (90) days from 
the date of purchase as evidenced by a copy of the receipt.  E-MU / 
ENSONIQ's entire liability and your exclusive remedy will be 
replacement of the compact disc not meeting this warranty.  The 
Software is provided "AS IS" and without warranty of any kind, and E-
MU / ENSONIQ and E-MU / ENSONIQ's licensors EXPRESSLY DISCLAIM 
ALL WARRANTIES, EXPRESS OR IMPLIED, INCLUDING THE IMPLIED 
WARRANTIES OF MERCHANTABILITY OR FITNESS FOR A PARTICULAR 
PURPOSE.  FURTHERMORE, E-MU /ENSONIQ DOES NOT WARRANT 
THAT THE FUNCTIONS CONTAINED IN THE SOFTWARE WILL MEET 
YOUR REQUIREMENTS, OR THAT THE OPERATION OF THE SOFTWARE 
WILL BE UNINTERRUPTED OR ERROR-FREE, OR THAT DEFECTS IN THE 
SOFTWARE WILL BE CORRECTED.  E-MU / ENSONIQ DOES NOT 
WARRANT OR MAKE ANY REPRESENTATIONS REGARDING THE USE OR 
THE RESULTS OF THE USE OF THE SOFTWARE IN TERMS OF THEIR 
CORRECTNESS, ACCURACY, RELIABILITY OR OTHERWISE.  UNDER NO 
CIRCUMSTANCES, INCLUDING NEGLIGENCE, SHALL E-MU / ENSONIQ 
BE LIABLE FOR ANY DIRECT, INDIRECT, PUNITIVE, INCIDENTAL, 
SPECIAL OR CONSEQUENTIAL DAMAGES, INCLUDING, BUT NOT 
LIMITED TO, LOST PROFITS OR WAGES, IN CONNECTION WITH THE 
SOFTWARE EVEN IF E-MU / ENSONIQ HAS BEEN ADVISED OF THE 
POSSIBILITY OF SUCH DAMAGES.  CERTAIN LIMITATIONS HEREIN 
PROVIDED MAY BE PRECLUDED BY LAW. 
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